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Description 
The evolution of Revit software for engineering, modeling, and design is having a major impact 
on the MEP design process. Autodesk continues to add new features, but bells and whistles are 
not the only things a user needs to understand. Taking advantage of key workflows can help 
you get more from your Revit tools than ever before. This hands-on lab will begin with an 
overview of the electrical improvements to help represent a more accurate design, and then 
we’ll move into new elevation features that affect all disciplines. Next, we’ll take a look at ways 
to improve your engineering analysis results, and we’ll close with new ways to move your 
schematic designs from AutoCAD software to Revit. Shore up some weak areas in your 
everyday work by learning how to use these tools and get more from BIM! 
 
Speaker(s) 
David Butts is an Autodesk Expert Elite Team member and Engineering Technology Manager 
for Gannett Fleming with over 34 years of experience in the architecture, engineering, and 
construction field. He is responsible for implementation, training, BIM project support, and 
management for engineering design applications, including Revit, AutoCAD P&ID/Plant 3D, 
AutoCAD MEP, Navisworks software, and more. He was an Autodesk Authorized Training 
Center (ATC) training manager and application engineer for an Autodesk Reseller for 13 years, 
providing implementation and training services across the United States, and serving as a 
Subject Matter Expert for Autodesk, engineering software, training and certification programs. 
He has design experience for a variety of project types, and he was an Autodesk University top-
rated speaker for labs and lectures in 2011 and 2016. 
 
 

 
 

Learning Objectives 
• Gain an overview of key electrical features that improve the design process 
• Examine new elevation and control features for scheduling and tags 
• Learn how to improve engineering analysis tool results with key settings and tips 
• Learn how to push more design into your model by incorporating HVAC and 

electrical schematics 
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Introduction  
 
The evolution of Revit software for engineering, modeling, and design is having a major impact 
on the MEP design process. Autodesk continues to add new features, but bells and whistles are 
not the only things a user needs to understand. Taking advantage of key workflows can help 
you get more from your Revit tools than ever before. This hands-on lab will begin with an 
overview of the electrical improvements to help represent a more accurate design, and then 
we’ll move into new elevation features that affect all disciplines. Next, we’ll take a look at ways 
to improve your engineering analysis results, and we’ll close with new ways to move your 
schematic designs from AutoCAD software to Revit. Shore up some weak areas in your 
everyday work by learning how to use these tools and get more from BIM! 
 
Key Revit Electrical Features and Improvements for 2020 
 
We’ve been training our users for years about how systems and circuits are defined, but the key 
is to understand the relationship between target and source devices. A target is any item that 
receives air, fluid or power, while a source controls the flow of air, fluid or power. Systems and 
circuits are always defined by targets and can have as many devices as needed within the 
system or circuit. But the system can only have one source – so from an electrical standpoint, 
the panel (and the relative breaker) are the source, while lights, disconnects, and other powered 
devices are the targets. In Revit, you’re always building your systems and circuits from the 
bottom – the targets – up to the ultimate source (power connection, water connection, air 
handling unit, etc.). 
 

Feeding the Lug 
 
The first key new feature to review is the ability to define feed-thru lug (that’s FTL) power 
connections between panels. Prior to adding this feature, the user had to “fake” connections 
between FTL panels. Circuit numbering was also an issue, so let’s begin by setting up an FTL 
connection. 
 
1. From the Revit model, FTL Panels – 2020.rvt, make sure you have the 1-Power view 

open. 
2. The plan contains lighting and receptacles, along with three panels: 
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3. Start by selecting panel PP3 in the upper left corner of Space 1. Review the properties 
palette, Electrical – Circuiting section: 
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The new features for the panel are the Feed Through Lugs, SubFeed Lugs and 
Circuit Numbering Option. For this exercise, start by making sure the Feed Through 
Lugs option is deselected, and Subfeed Lugs is also deselected. Click Modify on the 
ribbon or press ESC twice to clear the selection after you’ve applied the changes.  
 
4. Select one of the receptacles in Space  2 and then select the Electrical Circuits tab 

from the ribbon to show the circuit information: 
 

 
 
5. There have been several improvements over the past year, including the newer Edit 

Path tool that allows you to physically create the path for the circuit and create a more 
accurate voltage drop.  

 
Underneath the selected panel (PP1) note the new Connection Type which is set to 
Breaker. This is the traditional method that Revit has used to create the circuit – it’s 
been a simple breaker connection that is based on the voltage and number of poles 
defined by the targets, and totals the load based on the apparent load, load 
classification, demand factor and power factor.  
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6. Select the breaker drop down to see the new Feed Through Lugs option. This option 
is used when creating an FTL connection between panels – so don’t use it when 
creating typical circuits! Press ESC twice to clear the selection. 

7. To create a new circuit, select the group of lights to the left of Space 2: 
 

 
 

8. Note the Modify Light Fixtures tab – to create a circuit for all of these devices, select 
Power on the Create Systems tab: 
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9. By default, if any panel has had items added to it, Revit will automatically place the next 

group of circuited devices to the last panel used. If no panel was used, you can 
select the panel. For this circuit, make sure the panel PP3 is selected. Note that the 
breaker option below, which was also the last option used, appears by default. This is 
the correctly defined circuit that is associated with the breaker. 

10. Next, let’s review the loads on Panel PP3. Select the panel, and then select the Create 
Panel Schedule tool from the Electrical tab on the ribbon: 
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11. For this exercise, use the Default template. Once the schedule appears, note the loads 
on the panel: 
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12. The panel is carrying 1772 VA total load. In a feed through lug situation, this load needs 

to carry forward to the top panel.  
13. Next, let’s create the feed through lug relationship – the process is the same as when 

you’re defining circuits. In this case panel PP3 is the target, which defines the circuit, 
and panel PP2 is the source. From the 1 – Power view, select panel PP3 and then 
select the Power tool on the Modify tab, Create Systems panel: 
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14. By default, the circuit will default to breaker – but let’s switch this to Feed Through Lug 
by selecting this option under the Connection Type: 
 

 
 

15. If you have not set the PP2 panel up to support Feed Through Lugs prior to making the 
connection, you’ll get a warning about it. But now – get this – the tool actually helps you 
fix the solution by including the option to Enable Feed Through Lugs: 
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16. To set up a panel to use FTL connections as a default, select Panel PP1 and review the 

Properties palette: 
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17. At the bottom of the Properties palette for electrical equipment, review the Electrical – 
Circuiting section. The first option, Feed Through Lugs, is the check box than enables 
the panel to accept FTL connections. If you want to connect Panel PP2 to PP1 as a feed 
through lug connection, you won’t be prompted with the error message – Revit will 
simply create the connection. Select Panel PP2 and then select the Power tool from the 
Create systems tab: 
 

 
 

18. Next, from the System Tools tab, select the Panel PP1 from the Panel drop down, and 
Feed Through Lugs for the Connection type: 
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19. The circuit is now attached as a feed through lug connection. To see this, select panel 
PP1 and then create a panel schedule using the default template.  
 

 
 

20. But wait – something is missing…the load at the bottom of phase A doesn’t match the 
total of the panel PP1. It’s actually a lot more…4652 VA is the total of ALL of the 
connected panels. PP3, PP2 and their loads are included in the total, but this schedule 
template isn’t formatted to show the separate loads. So how do you fix this? While you’re 
in the panel schedule, select Change Template. Select the Feed Through Lugs Panel 
template: 
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21. If you get the warning about changes to the panel template may be lost for the current 
template, you can ignore this if you didn’t change the title area of the panel schedule by 
adding text. Be aware that anytime you manually add text to a panel schedule instead 
of using a shared parameter in a field area, you could lose that text since it’s not 
associated with the panel. 
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22. Click Yes, and now you using the template showing the FTL connected loads at the 

bottom of the panel schedule: 
 

 
 



 

 
Page 16 

23. The next issue that you could come across would be the panel itself – what if you only 
want the PP2 panel to be a feed through lug, and have PP3 set to a specific breaker? 
You can change the connection type properties at any time, by selecting the panel 
whose behavior you want to change.  

24. From the 1 – Power view, select PP3, and then select the Electrical Circuits tab. The 
system Tools tab will appear. From the Connection type drop-down, select it and 
choose the Breaker option: 

 

 
 
25. Once this is selected, note that the properties palette changes from Feed Through 

Lugs to Breaker, and the circuit number is assigned to the next three pole breaker that 
is available on PP2: 
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26. The Panel Schedule you created earlier for panel PP2 will now show the connection of 
PP3 to the schedule.  



 

 
Page 18 

 
 
Setting the Numbering Options 
 
Now that we’ve covered how to create the connection, let’s review how we can set the panel 
circuits to be correctly numbered. 
 
1. Make sure you have the FTL Panels – 2020 – Part Two.rvt file open, have the 1-Power 

view set current. Select panel PP2 and review the properties palette – locate the 
Circuit Numbering Option under Electrical – Circuiting: 
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2. This option is set to Default, which allows each panel to use individual circuit numbers 
specific to the panel. But what if you want to continue the panel numbering onto the next 
panel? Change this setting to Continue Numbering: 
 

 
 

3. After making the change, open the Panel Schedule for panel PP2, and review the 
change: 
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4. The circuit numbers (as well as any tags calling out the numbers on a plan view) will be 

updated to match this new circuit numbering scheme. 
 
One note: Revit still maintains a 1:1 relationship between the panel and panel schedule, so the 
functionality to place two panels under one 84 slot schedule is not available…(yet?). But you 
can have two panels with the same name, with two different schedules, using the continued 
numbering. 
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Try these neat tricks for Smoother Revit Electrical skin! 
 
Sometimes it’s the little things that drive the drafter in us crazy, so here’s a few new features 
that should make your documents much cleaner. If you’re one of the ones that still add wires to 
a view, take heart. There are several new features to make these work better: 
 

1. The fastest way to add wires is to create the circuit first, and then use the tab selection 
to pick everything on the circuit. Hover the cursor over a receptacle in Space 4: 
 

 
 

2. A preview of all of the devices will appear – take care not to move the mouse, as once 
you move it, the preview disappears. Once you see the preview, left click: 
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3. This starts the add wire command, where you can select either the arc grip or chamfer 

grip to add the wire. Select the arc grip to add the wire: 
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4. Now that the wire is added, here’s where the new features are. The old home run wire 

might be stretching across the building, the parking lot, into the street and across the 
road. The new default length (a built-in value that’s not editable) shortens the wire up to 
where it’s closest to the last device circuited, based on the scale of the view. You can 
still select the home run wire, and use the grips to stretch and edit it: 
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5. Now personally, the leader really is…ugly. With 2020, there are some new home run 

styles you can select from the Manage Tab, Setting panel, and MEP Settings. Select 
the electrical settings to open the dialog, and then select Wiring: 

 

 
 
6. Select the drop down for the Home Run Arrow style, and pick something else (in my 

case, I’m partial to the Arrow Filled 30 degree): 
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7. After selecting this, click OK to close the dialog and return to the view. Now this is nice 
fat style that’s easier to see: 

 
 

8. To try another feature improvement, select all of the lights adjacent to Space 4, and 
create a circuit to panel PP1. The preview automatically appears, when the circuit is 
defined. Click the arc grip to add the wires: 
 

 
 

9. Next, let’s delete both home run arrows. Using the wire command, add an arc wire from 
the last receptacle on this circuit to a light fixture on the new circuit: 
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10. This used to drive me nuts, since I didn’t want to see the arrow on this wire when trying 

to create a multi-circuit home run. To fix this, select the MEP Settings tool again, 
Electrical settings and then click wiring again: 
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11. Note how the Arrow for Multi-Circuits Home Run is set to Multiple Arrows – let’s 
change this to Multiple Arrows on End Wire Only: 
 

 
 

12. Click OK. This will fix the first wire and remove the arrow – now let’s add the home run 
back to the last light by adding another arc wire with three points, and the last point in 
the direction of the panel: 
 

 
 

13. IT WORKS! The wiring is actually correctly represented…even the number of tick marks! 
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Elevating Your Objects, Tags and Schedules 
 
Revit was not originally designed by architects, but by the same developers that created 
modeling software for equipment. The terminology wasn’t really clear, and it definitely 
took some getting used to. The 2020 version finally improves on this, by adding 
elevation parameters to help clear up where your content is placed. 
 

New Labels! 
 
Component families have an improved behavior to locating items in a model. Elevation is now a 
built-in parameter for use in tags, schedules, and view filters. This means that you don’t have to 
define a shared parameter for it to be used, but it appears automatically for the following family 
categories: 

• Air Terminals 
• Casework 
• Communication Devices 
• Data Devices 
• Electrical Fixtures 
• Electrical Equipment 
• Fire Alarm Devices 
• Furniture 
• Generic Models 
• Lighting Devices 
• Lighting Fixtures 
• Mechanical Equipment 
• Nurse Call Devices 
• Planting 
• Plumbing Fixtures 
• Security Devices 
• Sprinklers 
• Sprinklers 
• Specialty Equipment  
• Telephone Devices 

Let’s walk through a basic change to review how this works.  

1. From the Elevations – 2020.rvt model, start by selecting the 1-Plumbing View to set it 
current. Select one of the wall-hung toilets in the view: 
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2. Note the new Elevation from Level is an instance parameter that appears under the 
Schedule Level parameter. This is stating that even though the family is a hosted item, 
associated with the Generic 8” wall, it still has an elevation value that is relative to the 
schedule level – in this case, it’s 1’ 5” from Level 1. In the past versions, this was referred 
to as the offset. The value is set within the family – to check it, select the Edit Family icon to 
open the family: 
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3. Select the Family Types icon on the Create tab, Properties panel and review the 
Constraints section. The default elevation value has always been a part of the hosted 
families, but once the family is loaded, the value is now associated with the Elevation from 
Level parameter. Don’t get confused by the different names – it’s the same value and has 
the same result. 

4. Close the family without saving the changes and return to the 1 – Plumbing view. Select the 
fixture and change the Elevation from Level value to 1’ 7”: 
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5. Now, create a section view that faces the wall with the fixtures: 

 

 
 

6. This has always been one of the nice features of Revit – the fact that changing a value in 
plan view also takes effect in the section, elevation and model view. By simply selecting the 
fixture, we know that it’s placed at the correct elevation, without having to run a dimension to 
the device. 
 

7. Next, change to the 1 – Power view, and select one of the light fixtures: 
 

 
 

8. Note the additional instance property information – the same Level and Elevation Level 
values are displayed, along with the “host” and offset values. These are the same values, 
but also helps clarify something that can easily be confused: 
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“EVERYTHING IS HOSTED IN REVIT.” 
9. With non-hosted families, the actual host is the level the family is associated with – so if the 

level moves up or down, the values relative to the host stay the same. To test this, go to the 
South – Elec Elevation view: 
 

 
 

10. The lights in this model are non-hosted but are associated with Level 1. Select Level 1, and 
edit its properties so the elevation is set to -2’-0”: 
 

 
 

11. Watch as the lights move down with the level: 
 

 
 
The intent of the new descriptions is intended to help clarify the behavior of component 
families in Revit. 
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Exposing Elevation Data for System Components 

Until the 2020.1 release, Revit did not include a built-in parameter to recognize anything other than 
the centerline of pipe, duct, conduit and cable tray. Users had to resort to Dynamo or some other 
custom coding to expose import bottom and top elevations of system-based content. Autodesk has 
now added more ways to expose top and bottom elevations of duct, pipe, conduit and cable tray. 
Let’s check these out, as well as how to create the tag to read the value. 

1. From the Mechanical > HVAC > Floor Plans section, open the 1 – Mech view. From the 
ribbon, System tab, select the Duct tool: 
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2. Review the parameters that are available – top, middle and bottom elevation values are 
exposed. Select the Top Elevation parameter and set it to 8’: 
 

 
 

3. Note that all other values updated automatically. Place a few short sections of the duct in the 
main room as shown: 
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4. Note how the instance parameters stay current with the values – so the information is now 
exposed. But how can you use this? From the Project Browser, locate the Families section, 
and expand annotation symbols. Right click on the Duct Size tag and choose Edit to open 
the family: 
 

 
 

5. Once the file is open, select the Size parameter shown in the view. From the properties 
palette, you’ll see that this is a label, which reads information from the object: 
 

 
 

6. From the label parameter select Edit to open the dialog: 
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7. Under Category Parameters, you can see that there are now several options to add 
elevation properties to a tag. The built-in parameters now include: 

a. Bottom Elevation 
b. End Middle Elevation 
c. Start Middle Invitation 
d. Top Elevation 

 
Select Top Elevation, and then choose the green arrow to add the parameter to the label, 
below Size. Select Break on the Size line, and then add a space with TOD as the Suffix: 
 

 
 

8. This change will add the top elevation to the duct tag based on the instance property 
shown. If you use this with a datum annotation, it can also read the top location of a sloped 
duct, based on the selection point chosen. Click OK to complete the step, and then note 
the label change. Use the grips to spread the label out to allow the value to be added 
without a carriage return: 
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9. You can save the family if you want to keep it, but for this exercise, select Load into Project 
to replace the existing tag. Make sure you select the option to override the existing version 
and its parameter values, so the label is updated: 
 

 
 

10. From the Project Browser, drag and drop the tag into the 1 – Mech view and select a duct 
to label it: 
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Prior to this change, you had to create a parameter that included a formula to calculate half 
of the duct height value then add it to the middle elevation value or create a Dynamo 
programming routine to extract to a separate parameter. Since the parameter is now 
exposed, it’s a simple matter of just adding it to a tag. The same process applies to pipe, 
conduit and cable tray as well. Now, the elevation values are lot more useful. 
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Improve Engineering Analysis Tool Results with Key Settings and Tips 
 
Autodesk made major improvements to the energy and HVAC load analysis tools with the 
2020.1 release. For example, the legacy HVAC and Cooling Loads tool uses the ASHRAE 
Radiant Time Series method that only provided the loads: 
 

1 
 
Around 2013. Autodesk began making investments in EnergyPlus, the US Department of 
Energy’s primary tool for whole building energy analysis. For later reference, check out this 
article explaining the reasons behind this change: 
 
https://blogs.autodesk.com/insight/why-is-autodesk-investing-in-energy-plus/ 
  

 
1 Reference: The Radiant Time Series Cooling Load Calculation Procedure, Jeffrey D. Spitler, Ph.D., P.E. Member ASHRAE; Daniel 
E. Fisher, Ph.D. Member ASHRAE; Curtis O. Pedersen, Ph.D. Fellow ASHRAE; Copyright ©1997 ASHRAE, 
https://hvac.okstate.edu/sites/default/files/pubs/papers/pre_2000/19-Spitler_Fisher_Pedersen_97.pdf 
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Here’s the specific reasons quoted in the link for why Autodesk made the investment: 
 
• “We believe EnergyPlus is the most advanced whole building energy analysis engine 

available in the market. Sure, there are other engines that are better at specific things, 
but when you add it all up, we believe EnergyPlus usually comes out on top overall. 

• Even though EnergyPlus is very accurate, considering the latest in building science and 
enabling capabilities like green roofs and natural ventilation, it is slow and very hard to 
use with BIM applications. 

• We thought that Autodesk could address the limitations of EnergyPlus, and do it in such 
a way to benefit the industry at large. We also did not see anyone else willing to put the 
effort required to address the limitations of EnergyPlus. We decided if we did not do it, 
nobody else would and the industry at large would be the worse for it. We have the 
resources and we know it was the right thing to do.  The classic “If not Autodesk, then 
who? If not now, then when?” 

• EnergyPlus has one other very important advantage over almost all other modern 
engines. It is open source. That means anyone can see the source code and improve 
upon it. EnergyPlus can be used by researchers all over the world to study how to 
reduce the impact of buildings on the environment without sacrificing cost or occupant 
comfort. In the long run, open source core technology has shown to be equal to, if not 
better than, proprietary products. Obviously, the core technology must be valuable 
enough to have a community to rally around it. To support that hypothesis, here are 
just a few examples: Linux, OSX, Android OS, Mozilla, and the list goes on. All of these 
have open source as their underlying core technology with customized and sometime 
proprietary UI on top of them.” 

 
Fast forward to Revit 2020.1 – the first fully integrated version of Revit that leverages the 
Energy Plus tools is released.  
 
But this section of our lab is NOT about performing the analysis – it’s about what happens 
before the actual analysis takes place. It’s about understanding what can cause errors, and how 
to improve the accuracy of the results.  
 
 

In the Beginning – Energy Model Settings 
 
Making sure you understand how the project settings impact your project is critical to running a 
successful analysis. For this exercise, make sure you are in the Analysis Settings_R20.rvt 
model. 
 
1. To begin, go to the Manage tab, Settings panel and click Project Information. The 

dialog will appear: 
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2. Select Energy Settings to continue: 
 

 
 

3. Select Mode – the most common error that occurs when the incorrect mode is used: 
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4. If your building doesn’t contain mass elements, then this should ALWAYS be set to Use 

Building Elements. Conceptual masses only apply, for example, in an architectural 
model, in a very early predesign phase, where the masses represent the concepts of an 
overall building: 

 
5. However, most of the projects we see in the Autodesk support portal that have issues 

with energy modeling don’t include the masses, so check this first. Next – so if you are 
using Building elements, what does that mean? Revit is using the actual building 
geometry – walls, openings (including doors, windows, curtain walls, etc.), floors, roofs, 
and ceilings – as the “bounding elements” or envelope that defines the conditions for the 
energy model. While you are still in the Energy Settings dialog, select Other Options, 
and open the Advanced Energy Settings dialog: 
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6. Take a look at the Material Thermal Properties section. This area is where Revit settings 
are defined that tell Revit how to deal with the bounding elements. Conceptual types 
are specific to Conceptual Masses. If you select Edit, you’ll see some basic settings for 
how Revit can view the masses from a building envelope perspective: 
 

 
 

7. These settings have no impact on any building elements, so they are used when 
you have the conceptual mass model as described above. Click Cancel to return to the 
previous dialog, and click Schematic Types: 
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8. If you don’t have the Detailed Elements option selected in the Advanced Energy 
Modeling dialog, then Revit applies these overall settings to ALL roofs, exterior and 
interior walls, ceilings and more. These are general assumptions – so if your model is 
still in a preliminary stage, even if you are using general object types, you can address 
the thermal properties by selecting different Analytic Construction types. For example, 
here’s a sample of some of the exterior wall constructions: 

 

 
 
Super-secret tip: You can find these settings in the C:\Program Files\Autodesk\Revit 
2020\en-US\Constructions.xml file, where en-Us is the version of Revit you are using. 
But edit this at your own risk – and make a copy before editing! 
 
9. But we’re still not there yet, if you are looking for even more detail. Click Cancel to exit 

from the schematic types dialog, and make sure you have Detailed Elements checked: 
 

 
 
10. One last step – if you’re doing this from an architectural model, change the Export 

Category to rooms. If you’re doing this from a MEP model, make sure the architect 
actually added rooms – correctly – to their model. The rooms should be bound on all 
sides in order to get an accurate representation. If they did, make sure you place 
spaces, and have this option selected. We’ll cover the spaces a little further in the class. 

 
11. Click OK to exit the Advanced Energy Settings and return to the Energy Settings 

dialog. A new feature that was added to the bottom of the Energy Analytical Model 
category – Average Vertical Void Height Threshold and Horizontal Void/Chase Area 
Threshold: 
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12. As modelers, we tend to get lazy. Added a plenum level and spaces to represent 
interstitial spaces can be a bit tedious. Instead of having the user add these items to the 
model, the Vertical Void height allows Revit to assign these areas to unconditioned, 
and the threshold is set by dividing the volume by area. 
 

13. Horizontal voids are the same thing – if an area enclosed in the building is 1 square 
foot or less (for US Imperial units) as the default setting, then Revit sees this space as 
unconditioned.  
 

Both of these setting help reduce the time needed to assemble an energy model baseline – you 
can still do the tasks of adding levels and spaces if you want to raise the accuracy level of the 
model, but for most use cases, these settings should be sufficient for a preliminary model 
review. 
 

Resolving Space and Boundary Errors 
 
After reviewing the energy settings, there are still several items that can cause an energy 
analysis model to fail. Knowing how spaces are defined, and how they interact with the 
bounding elements of the model, is crucial to understanding how to create a well-defined 
environment. Let’s take a look at a few items that are commonly missed. 
 
Make sure you have the Space Settings_R20.rvt model open. 
 

1. Select the SECOND FLOOR HVAC PLAN and make sure it is the current view. Adding 
spaces is a fairly simple exercise – the spaces are needed to create a well-formed 
energy model, so let’s add them quickly to the model. From the Analyze tab, Spaces & 
Zones panel, click Space: 
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2. After the tool is activated, check the Space Height value – the offset is 13’4” above the 

second floor, so we should not have any issues reaching the ceilings. Click Place 
Spaces Automatically, and the spaces will be added to the model: 
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3. You’ll get a warning about not being able to create the geometry for the Space, but 
hey…no worries. Let’s get the energy model created and move on. Select the Create 
Energy Model from the Energy Optimization tab:  
 

 
 

4. The friendly warning about this may take some time will pop up. Be aware that they 
mean it. If you have a 2GB model with 125 linked drawings and 73 linked Revit models 
that have 16 different phases, then yes – it will take a while. Click Create the Energy 
model to carry on. The model will take a few seconds in this case, and when it finishes, 
we should get a nice model view showing the analytical spaces…but we get this instead: 
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5. Only a handful of spaces appear, and it’s a direct result of poor modeling practice. In 
order for analytical spaces to be correctly defined, they have to be completely bound – 
on all sides – by bounding elements that are also correctly defined. There are no 
shortcuts here – the poorer the quality of the model, the less likely you will get a 
good energy model result. 

6. To fix this – where are the missing bounding elements? Let’s get the model back to 
where we started. From the UNDO drop down, select the Find All Spaces command, 
which was used to add the spaces to the model: 

 

 
 
7. Next, from the Insert tab, go to the Link tab and select the Manage Links tool. Note 

that the 56750_S_R20.rvt model is unloaded: 
 

 
 
8. Select the link name and pick reload. Click OK to complete the command, and the 

structural model will be linked back into the model: 
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9. Back in the SECOND FLOOR HVAC PLAN – go back to the Analyze tab, Spaces & 
Zones panel, and repeat the steps to add the spaces back to the model. Once the 
spaces are added, run the Create Energy Model tool again. After the tool is finished, 
take a look at the Space Analysis model view again: 
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Now the model is much better formed than the previous – because even within linked 
models, the bounding elements must be well-formed. Don’t make the mistake of 
assuming the architectural model will be the single source of energy modeling content 
for the model, but instead get back to your BIM PEP, and clearly identify not only who 
owns the model elements, but whether they need to be room bounding as well.  
 

The Space and Building Types Are Better…for your Model! 
 
In addition to making sure you have a well-formed model, it’s important to review the 
building and space types that are applied to the project. These items store critical energy 
modeling data in regard to occupancy, operations, air flow and power/lighting density 
loads. 
 
1. To access the building and space types, open the Manage tab > MEP Settings > 

Building/Space Type Settings: 
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2. The default building types that come with Revit are based on the ASHRAE 90.1 
building types. Each type includes heat gain, density and scheduling data that’s needed 
to determine the overall use of the building. Review the new settings – with EnergyPlus 
as the core modeling engine now, additional settings can be defined. You can adjust 
Opening and Closing times directly in addition to the occupancy schedules. To 
leverage today’s managed heating and cooling systems you can also set the 
Unoccupied Cooling Set Point for the entire building. 

3. At the bottom of the dialog, select the Hospital or HealthCare building type. Once it’s 
selected, select the Duplicate icon at the bottom of the screen – this will create a new 
type with a (1) in the suffix. Rename the type to 24 Hour Care Facility: 
 

 
 

4. You can use any existing to create new variations that may have subtle differences and 
allow for a more accurate analysis. Set the opening time to 12:00am and the closing 
time to 12:00am to represent a 24-hour cycle.  
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5. You can also set the Occupancy Schedule to On – 24 Hours to represent a full 

occupancy at all times. This helps generate a worst-case scenario for heating and 
cooling conditions. After adjusting the occupancy schedule, click OK to save the 
changes and close the dialog. 

6. Next, change the dialog option to Space Type by selecting the button at the top of the 
dialog: 
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7. It’s a good idea to edit the default space types in your template – as well as define a 
template based on the type of construction or building you are modeling. The space 
types override the building types at the individual areas of the model. This helps provide 
greater detail for the heat gains, density and schedule data. Review the settings for 
Active Storage – Hospital/Healthcare and Office - Enclosed. Click Ok to close the 
dialog when you’re finished. 

8. To apply the building type, open the Energy Settings shortcut from the Analyze tab > 
Energy Optimization panel: 
 

 
 

9. This will open the Energy Settings dialog – select the Other Options > Edit icon to 
open the Advanced Energy Settings. Now that you have the new 24-hour Care 
Facility type defined, you can select it as the default building type: 
 

 
 

10. Click OK twice to exit the dialogs and return to the project. Make sure you have the 
SECOND FLOOR HVAC PLAN open. Now that you’ve added the spaces, update the 
names so they match the rooms from the architectural model. From the Analyze tab, 
click Space Naming: 
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11. When the dialog appears, the tool will default to updating all spaces for all levels – 

click OK to complete this step. 
 

 
 
12. Now that the names are displayed, select one of the DR OFFICE spaces, and review the 

Properties palette. Locate the Energy Analysis section and note that the Space Type 
is set to <Building>. Select this line to change this to a specific space type: 
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13. By assigning the space type, you’re providing more detail for the analysis model. 
 
BIG TIP – create a space schedule for your model, so you can see all of the spaces – 
open the one that is already defined in this project. It’s a lot easier to make these 
changes from the schedule, as well as see any spaces that are not well-formed (and 
delete the from the project): 
 

 
 
This is one of the steps that’s commonly ignored but can bring a ton of benefits to the 
analytical model. Don’t skip these settings – make sure you review them after you get 
your spaces defined. 
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It’s a Material Thing 
 
The last feature we’re covering is the most ignored benefit that Revit can provide, and both 
architects and engineers are guilty of skipping it. Material definitions that are assigned to 
bounding elements – walls, openings, floors, roofs, etc. – can include thermal properties in 
addition to pretty images and hatch patterns. There are some of the most critical settings that 
can impact the model when the Detailed Elements option is selected. We will use the Material 
Editor to review some of the common materials and make sure they are correctly assigned to 
wall types. 
 
1. Open the Detailed Architectural Elements.rvt model. From the Manage tab > 

Settings panel, click Materials. 
 

 
 
2. When the dialog is first opened, a list of materials that are stored in the project is 

displayed. Scroll through the list and select the Brick, Soldier Course. Select the 
Thermal tab, to display the information and properties: 
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3. The properties define the thermal characteristics of the material – including behavior, 
conductivity, specific heat, density and more. Scroll down and select Concrete Block: 
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4. Not all materials include thermal properties. If you want to use the material and add the 

thermal properties, select the plus sign tab – the Asset Browser will appear: 
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5. Autodesk ships several libraries with Revit, including materials of other regions across 

the world. The default library that includes thermal properties is the Autodesk Physical 
Assets library. By selecting the Thermal option, the list is automatically filtered to 
display predefined options. Scroll through the list and locate Concrete. Select the arrow 
to load this asset to the current material, concrete, in the Revit project: 
 

 
 

6. Once the material is loaded, a double arrow will appear. If the material is modified 
incorrectly, you can select the option to replace the asset in the project with the material 
from the library: 
 

 
 

7. Once the asset has been added to the material in the project, you can return to the 
Material Browser and edit the properties, including the name, description and other 
thermal properties. 

8. After adding the material, the last critical step is to make sure the material is assigned. 
The best way to handle this is to assign it the system family (such as a wall) or 
component family (such as a door or window). If you want these items to appear for 
every project, make sure you add them to your template. If it’s a component family, you 
can associate a material with the 3Dsolids used to define the component, such as the 
door panel, window sash and more. For example, if you select a wall, you can select the 
Edit Type option and review the properties. This particular example of an interior wall 
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shows the analytical properties – they are “greyed out” because the materials assigned 
the structure define the thermal properties: 

 
 
9. To edit the default value, select the Edit button for Structure: 
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In this case, the thermal properties are assigned by the material as listed in the Edit 
Assembly tab. As long as the materials are using Thermal properties, and the analysis 
model is being told to use Detailed Elements, these properties will be used as part of 
the energy model analysis. 

 

Last Words on Energy Modeling… 
 
Keep these rules about energy and load analysis handy – you’ll be much happier with the 
results. 
 

1. These tools are always best used at the START of a project, when detail levels are low. 
The more geometry you have in a project model – including furniture, equipment, highly 
complex assemblies and more – the longer and less effective the tool is. The purpose is 
to help you in the early stages of a project determine what options you have available, 
and how they can affect the overall energy consumption of the building or structure you 
are working in. 

2. Energy modeling is a TEAM effort. All of the players – architectural, structural and MEP 
have to buy-in to setting up their models correctly and including the correct assignments 
from the materials up to the building type. But Revit is also forgiving and will let you use 
default overrides in the MEP model settings. 

3. Remember that the model must be properly bound – this includes walls, openings, 
floors, roofs and ceilings. Rooms and spaces must also be included. Don’t skip steps or 
cut corners here – without these, you won’t get a good analysis. This also applies to 
linked models – make sure they are set to be room bounding. 

4. Avoid “over bounding” – not every item in a room needs to be set to room bounding. 
Column enclosures are a great example – they have little impact on the overall energy 
model. 
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5. Check your energy settings – understand the differences between conceptual masses 
and building elements and when to use each, or both. 

6. Assign your building and space types appropriately.  
7. Review the materials and their thermal properties if using the Detail Elements option. 
8. Keep your DWG’s out of the model!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
 
 
In the End…Schematics in Revit 
 
Most firms are still dependent on AutoCAD for creating schematic diagrams, such as process 
and instrumentation, electrical and plumbing risers, and process flow diagrams. But even then, 
you still need some level of customization over base AutoCAD to make it efficient. AutoCAD 
MEP and Plant 3D both contain schematic layout tools, but not all users have these licenses in 
a collection.  
 
So how do you get AutoCAD out of the loop – and start doing things in Revit? It begins with 
some understanding of detail families, annotation families, and nested family behavior. We’ll 
start by examining the detail items first. 
 

The Symbol 
 
There’s only going to be one rule that applies to schematics – everything needs to be produced 
at 1:1 scale. If you can stick to this rule, life will be good. Detail items are best used for 
schematic linework that represent the symbol itself. To get the symbols right, it’s best to set up a 
schematic family template that contains the line styles and types you need. 
 
1. Make sure you have the family, Schematic Symbol.rfa open. This file contains 

examples of line patterns you can use to create your own library, but detail families 
require that you add subcategories to the Detail Items category that defines this family. 
From the Manage tab, select Object Styles: 
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2. This example shows how you can use object style subcategories to define the 

linework. You can edit the properties of the subcategory from the Object Styles tool, 
under Model Objects, Detail items after the family is loaded into a project. Detail 
families do not support the creation of line styles, so this is where the linework needs to 
be defined. This family already includes examples of subcategories you can use. 

3. Next, create reference planes that can be used to align linework associated with a 
symbol. From the Create tab, Datum panel, click Reference plane. Draw four reference 
planes as shown: 
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4. In this example, you are adding four planes around the insertion point, so the part will 

be placed from the center of the primary center front back and center left right planes. 
Next, add dimensions to allow the user to set the width and length of the box: 

 

 
 
5. To create the EQ dimension as shown, run a string of dimensions from an outside 

reference plane, to the center plane, and then the opposite plan. You can select the 
dimension and use the EQ grip to create equidistant spacing. After placing all of the 
dimensions, select the overall dimensions (indicated by having a distance) and add two 
labels, length and width as shown: 
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6. After the labels are assigned, your family should appear like this: 
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7. Next, select the Family Types dialog from the Properties panel to edit the default 
values: 

 

 
 
8. Don’t skip steps here – make sure you name your type. If not, the type in the project will 

take on the name of the family itself, and if you have multiple types in one family, you 
need to define each type within the family first. This example was named Instrument, 
and the length and width values were set to ½”. Click OK after making these 
changes, and the symbol should look like this: 
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Tip – set the SCALE for the view to 12” = 1’-0” to see the dimensions at the same scale 
that you want to load the family. Scale will still be determined by the detail view, but you 
can edit scale to allow annotations to resize in the model – the detail item will remain at 
the defined size, since it is not annotative. 
 

9. Now that the frame is defined, zoom into the center of the family to add the linework. 
From the Create tab, click Line to start the line tool. Set the subcategory to Electrical 
Schematic – Medium Lines, and use the Rectangle option to create the lines, 
snapping to the two intersections opposite of each other: 
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10. The advantage to using a rectangle is that all 4 constraints needed to look all four lines 

to the reference planes appear at once – click each one to lock them immediately to the 
reference planes: 

 

 
 
11. Now that the lines are added, save the family. Next, open the Schematic Project model 

and make sure you have the Schematic Layout drafting view open: 
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12. Switch back to the ref level view for the schematic symbol family, and choose Load 
into project from the Modify tab: 
 

 
 

13. Once the family is loaded, you can drag and drop the symbol by expanding the project 
browser to the Detail Items section, and expanding the family to show the instrument 
type: 
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After getting symbols defined, you can now start creating a schematic layout 
 

Adding the Schematic lines 
 
Once the symbols are loaded into the project, you can add detail lines easily. It’s just a 
simple step, but you also need to know how to get the linework to interact with the 
symbols. This includes having the symbol hide a line and anchoring the symbol to the 
line, so it moves when the lines moves. Let’s continue from our last steps to see how this 
works. 
 
1. After placing a couple of symbol examples in the Schematic Project, from the Annotate 

tab, Detail panel, click Line. This project already includes the schematic line styles 
(added from the Manage tab > Settings panel > Additional Settings > Line Styles). 
Select Electrical Schematic – Medium Lines for the line style used to create the 
linework: 
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2. This adds a line that goes over the symbols. But what if you want the symbol to mask 
the line? Add a masking region to the symbol family. Switch back to the Schematic 
Symbol family. From the Ref Level view, Create tab, Detail panel, click Masking 
Region: 
 

 
 

3. Using the same tools used to create the lines, add a rectangle to define the outline of 
the masking region, snapping to the lower left and upper right intersections. Make sure 
you click the lock grips to lock the masking region to the linework: 
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4. Click the green check to complete the step. Save the family, and then select Load into 

Project to load it into the Schematic Project. When prompted, overwrite the existing 
family. After it’s loaded, select the symbol if the line is not masked immediately, select 
Bring to Front to pull the symbol in front of the line: 
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5. Once the option is selected, the line will be hidden. You can constrain the symbol to 

the line by using the Align tool. Select Align from the modify tab, then select the 
linework first. Next, select the reference line within the Schematic Symbol to 
complete the task:  
 

 
 

6. Select the lock grip when it appears to create the alignment constraint. Now the symbol 
will move with the line. 
 

 
Now that the line and symbol are related to each other, the next step is to control what 
you see in the schematic. 
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Using Yes/No Parameters for Linework Visibility 
 
Old school AutoCAD drafters are all about their block libraries. A dynamic block in AutoCAD 
allows you to incorporate drop downs that allow you to swap out symbols through out the 
drawing. Revit has the same behavior with yes/no parameters that can be associated with a 
specific instance or type within a family. This example demonstrates how to add the visibility 
control to an instance of a symbol. 
 
1. To include additional linework, return to your symbol family, and add a circle as shown: 
 

 
 
2. In this case, a 1/8” radius circle was added. To control linework visibility with an on/off 

switch, select the circle. From the Properties palette, select the Associate Family 
Parameter button, then select New. Create a new Yes/No parameter named Circle 
Visibility. Make it instance based, and group the parameter under Graphics: 
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3. Click OK twice to get out of the dialogs. Save the family and reload it into the project. 
Make sure you select to override the parameters since you added a new parameter. 
After placing an example, select the family. The switch is now available under the 
instance properties of the family, allowing you to turn it on and off for each instance 
placed in the project: 
 

 
 

4. If you want to include text for a symbol, you can tag the detail item using a detail tag 
(there’s one included in the Schematic Project named Detail Mark Tag (for instance-
based mark values) or Detail Type Mark Tag (for type based values): 
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Wrapping up on some basics for creating schematic symbols. Here are a few rules: 
 
1. Avoid using annotation families the respond to scale. One of the biggest issues is that 

you cannot snap to linework in an annotation family, so it’s precluded from be using to 
creating anchored symbols. 

2. Model based detail families have their own issues – if you add them to the same project 
where you have the actual model elements, the model elements are counted…and 
tracked. I saw a recent presentation where Arup had created several diagrams using 
model elements, but the schematics were housed in a different project model than the 
actual physical equipment representations. Looking down the road, you might be able to 
create some plan views using links and schedule items in the linked model, but the extra 
work may not be worth the effort, 

3. Use your detail items like you do dynamic blocks – create a master file for a primary item 
like motors, AHU’s, fire alarm symbols. Create different types with each detail item family 
and use the visibility controls to control visibility by type. This helps reduce the amount of 
families you need to define, and help you organize your library in a much simpler 
manner. 

 
Conclusions 
 
There’s a lot going for Revit MEP, as Autodesk refocuses their efforts on MEP product 
development. For some recommended classes at this year’s AU that expand on these topics, 
check out these related classes and labs from some great instructors: 
 
CES320823 - Revit for P&IDs: A New Perspective on Design Synchronization for Water 
Projects – by Brian Melton: 
 
https://autodeskuniversity.smarteventscloud.com/connect/sessionDetail.ww?SESSION_ID=320
823 
 
BES321498 - Plumbing Revit MEP: Drop and Go—Let the Information Flow – by Ronal Balmer 
and Setah Burford 
https://autodeskuniversity.smarteventscloud.com/connect/sessionDetail.ww?SESSION_ID=321
498 
 
BES323529 - Revit Systems Analysis Features and Framework: An Introduction – Ian Malloy 
 
https://autodeskuniversity.smarteventscloud.com/connect/sessionDetail.ww?SESSION_ID=323
529 
 
Thanks for attending and have a great Autodesk University! 


